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1 INTRODUCTION

1 Intr oduction

1.1 What is ROME?

ROME stands for Research Operating System for Multimedia Engineering. ROME hasbeen developed
at NEC’s Computerand Communications Research Laboratory (C&CRL) in Princeton, New Jersey ,
as an effort to design and implementan operating system as a basic platform for multimedia research
applications.

ROME is anoperating system thathasbeendesignedto managehigh speeddatastreamswithin a multi-
mediaenvironment. Thesystem is highly modular, with functionality split betweenmultiple processes. To
ensure a high throughput with minimal overheadROME providesa zero copy architecture wherepointer
referencesto dataarepassedaroundinsteadof databeingcopied. Thegoalof thisapproachis to maximize
theutilizationof a givenhardware configurationmaking it possible to:

� Createhigh performancesystemswith muchhigherdata throughputthanconventional systems;

� Build fastapplicationsfor embedded,mobilesystemswith lower performanceCPUs.

Considering the latter point — especially in a world with moreandmoremobile computing devices,a
fastoperatingsystem ablefull y to exploit theavailable hardwareis essential for reasonableperformance.
ROME is designedto serve this purpose.

1.2 Sowhy do I needRTB?

Over timeROME hasevolvedaway from theresearchstateto averystableandefficient micro-kernelOS.
Many componentshave beenadded over time suchas:

� Hardwaredriversfor Ethernet, SCSI,graphics chipsetsandinput devices;

� Toolkits for Audio/Videosupport;

� Userwindowing system.

As moreandmorecomponentshavebeenaddedto ROME, it hasgottenmoreversatile but alsohasgotten
morecomplex to design, build andconfigure a ROME system. RTB solvesthis problemby providing a
GUI that abstracts ROME design, build andconfiguration proceduresinto an easyto useuserinterface.
This reducesthelearning curveandspeedsup ROME software development.

With RTB you caneasily createandmanageROME projects. You cancreate andaddnew components,
using themtogetherwith existing componentsthatarelocatedon a CVS server. You canchangeROME
system configurations andplay with different target system settings. All this functionality is integrated
into RTB.

7



1.3 Wheredo I getRTB? 2 OVERVIEW

1.3 Where do I getRTB?

RTB is distributedin a.tar.gz archive format.You cangetthepackagefrom:

http://rome.sourceforge.net

BrowsetheDownload section of thesiteandlook for theRTB package.

Thesource code for RTB is alsoavailable. You canobtainthesource code via CVS.SeetheCVS section
of thesitefor moreinformation.

1.4 Mor e useful information

Look at theGetting Started Guide for ROME to getmoreinformationonhow to download, install andrun
a ROME developmentenvironment. You canget the guideathttp://rome.sourceforge.net/
in theDocumentation section.

2 Overview

An overview of theRTB architectureis shown in Figure1. RTB accessesbothCVSrepositoriesaswell as
the local disk for existing ROME project componentssuchasModules, Targets andMessageSets. These
componentswill bedescribedlater in thedocument.

RTB doesnot integrateall the functionality that is neededto createa ROME system. For now, thecode
generationandcodedownloadhappensthroughexternal processes.RTB takescareof projectmanagement
andconfigurationandcreating thenecessarybuild files.

2.1 Project Build

Oncea project is defined andconfigured, RTB creates the necessarybuild files suchas the Makefiles,
certain Headerfiles andother configurationfiles thatareneeded to compile thecode.

2.2 Dir ectories

RTB createsandreliesonacertaindirectorystructurefor keepingproject information. Assuming/home/rtbuser/rtb
astheroot directory, RTB will usethefollowing setup:

/home/rtbuser/rtb/HelloWorld
/home/rtbuser/rtb/HelloWorld/Modules
/home/rtbuser/rtb/HelloWorld/Targets
/home/rtbuser/rtb/HelloWorld/MessageSets

Whenexecuting thebuild optionwithin RTB all theMakefileswill becreated within theModules direc-
tory. To build theROME target executable,you will have to runmake within thatdirectory.

8



3 INITIAL SETUP 2.3 Configuration file suffix

Projects

Executable
Target

(cross-gcc)
Compiler

Makefile
Project

Process
Build

Modules

Targets

MesageSets

Modules

Targets

MesageSets

CVS Local DiskROME Target Builder

Figure1: RTB architectureoverview

2.3 Configuration file suffix

RTB stores all its information in specific configuration files. All RTB configuration file usethe same
syntax andhave the suffix .rtb. Although these files only contain ASCII text andareeasily readable
using a standardeditor, it is not recommendedto changethis files manually. A simpletyping error could
corrupt a configurationfile, rendering it useless.As RTB frequently readsandwrites configuration files,
it might bepossible that information is lost if configuration files havebeencorrupted.

2.4 User interface look and feel

Many of RTB featurescanbeinvokedusinga toolbar button, the toolbar menuor thecontext sensitive
popupmenu(Figure2) whichcanbebrought upby clickingtheright mousebutton. It is alsopossible to
usehotkeyswhich activate certain functions.Thehotkey combinationfor a specific function is displayed
at theright sideof thatfunction in thepopup menu.

3 Initial setup

3.1 Starting RTB for the first time

Whenyou startRTB for thefirst time, it will create thedirectory.rtbrc in your homedirectory (Figure
3). Thisdirectory is usedto storeRTB configurationdatasuchastheproject list, preferences andtheCVS
repository list. Thefiles in this directory should never bechangedmanually asthis canresult in dataloss
or causeRTB to stopworking.

Also, the project list file andthe CVS repository list file will be created in this directory during the first
start.
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Figure2: Activating functionsin RTB

Figure3: First startup of RTB should bring up this window
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3 INITIAL SETUP 3.2 Basicconfigurationsettings

3.2 Basicconfiguration settings

At first startup RTB alsoinitializestheconfigurationsettingsto default values. Usuallythesevalueswork
well, however, it is recommendedthat you configure RTB to your specificneeds using the preferences
dialog (Figure4). To configureRTB usetheFile->Preferencesmenuor pressthepreferencesbutton in
thetoolbar.

Figure4: RTB preferencesdialog

3.2.1 Projects dir ectory

In theProjectstabyou candefinethedirectory whereyou wantto keepall your ROME projectfiles. Usu-
ally it’sagoodideato createadedicatedRTB directory in your $HOME directory (e.g./home/gnagflow/rtb).

3.2.2 CVS dir ectory

You candefinethe temporary directory that CVS will useduring your RTB session. Thedirectory must
be read/writable by you andshould have at least5 MB of availablefile space. Unless you have security
issues,/tmp is a goodplace.

3.2.3 Auto update project status

Enablethis checkbox, if you like RTB to update theCVS statusof theproject entriesautomatically once
you openthe project window. This way you will not have to updatethe statusmanually. However, you

11



4 RTB MAIN WINDOW

should only usethis option if you have a fastconnection to the CVS server. If you usee.g. a modem
dialup connection, you should not useautoupdate.

3.2.4 Build Toolsdir ectory

This entryspecifies theroot for thecompiler tool chain util ities. Notethat this is not thedirectory where
youkeep your tool chain executables(e.g.gcc). Thepathto theexecutableswill becreatedusing theCPU
typeandclass you specify in thetarget description (seechapter ).

3.2.5 Debug messages

With the“enabledynamicdebug messages”switchyoucandefinewhether or notRTB should print debug
messageson the standardoutput. This might be useful in caseyou encounter a problem with RTB and
wantto submit abug report. However, enabling this option might clutterup your terminalwindow, souse
it with caution.

4 RTB Main Window

Figure5 shows theRTB applicationmainwindow. Themainwindow appearsdirectly after RTB hasbeen
started. It shows a list of existing projectson your system.YoucanusetheProject menu to create, edit or
delete projects. As anexample, theproject “NAT Box” is usedthroughout this document.All mentioned

Figure5: RTB mainwindow

paths, directories andfilenamesreferto this particular exampleproject.
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4 RTB MAIN WINDOW 4.1 Creatinga new project

4.1 Creating a new project

To create a new project, you needanexisting CVS Repository. A project will alwaysbeassociatedwith
a CVS repository, andthis relation cannot bechangedafter theproject hasbeencreated. Soyou should
be sureto choosethe right CVS repository right from the beginning. If you do not have defineda CVS
repository at this point, seeChapter 9.1.1on page32 on how to adda new CVSrepository to RTB.

To create a new project select the in the Project->New menu. A dialog (Figure6) will pop up andyou
canenterthename, working directory andCVS Directory for thenew project. Onceyou hit OK, thenew
project entry will appear in theprojectlist andyou canstart editing thenew project.

Theprojectlist will beautomatically savedto disk.

Figure6: Creatinga new project in RTB

NOTE: The directory entry will automatically expand usingthe default directory from your RTB pref-
erencesandthe entered project name. However, you canchange the directory according to your
needs.

4.2 Editing a project

To edit a project, selectit from the list andclick on theProject->View/Edit menu.Theproject window
for theselectedentrywill appear on thescreen. In this window you canedit thepropertiesof theproject.
Seechapter5.5 for how to do this.

4.3 Deletinga project

If you want to delete a project selectthe Project->Deleteentry from the menu. You will be asked to
confirmyour intention. If you click YES,theproject will bedeletedfrom theproject list.

Note: Theprojectdoesstill exist in theprojectdirectory. Thatmeansthat thefiles arestill available and
arenot deletedby RTB. This is a featurethatshould prevent theaccidentallossof modifiedsource
files.
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5 PROJECTS

5 Projects

5.1 Project root dir ectory

A project is always associated with a particular directory on your hard drive. The path of this direc-
tory is constructed using the default project directory asdefined in the RTB preferencesdialog andthe
project name.For example, if your default project directory is /home/gnagflow/rtb/Projects,
our “NAT Box” project directory will be/home/gnagflow/rtb/Projects/NAT_Box. All non-
alphanumericcharacters of theproject namewill beconvertedto theunderscore(_) character.

5.2 Project entry types

RTB (or ROME, dependingon your view) definesthree different projectentry types:

� Targets

A target contains all informationthat is machinedependent. Usuallyyou createa target for a very
specific hardware suchas a single board, an embedded system or a specific configuration of an
evaluationsystem.

� Message Sets

A message setdefinesa setof ROME messages andevents for inter process communication in a
ROME system.

� Modules

Modulesarethebasicbuilding blocks of a ROME system.They contain theactual sourcecode.

5.3 Project dir ectory structur e

Within theproject directory thefoll owing directory structureis created to accommodatetheproject com-
ponents like Targets, Message SetsandModules. For the “NAT Box” examplethe following directories
will becreated:

/home/gnagflow/rtb/Projects/NAT_Box
/home/gnagflow/rtb/Projects/NAT_Box/Targets
/home/gnagflow/rtb/Projects/NAT_Box/Targets/DDB-VR4111U-eval-
board
/home/gnagflow/rtb/Projects/NAT_Box/MessageSets
/home/gnagflow/rtb/Projects/NAT_Box/MessageSets/Standard
/home/gnagflow/rtb/Projects/NAT_Box/MessageSets/Alarm
/home/gnagflow/rtb/Projects/NAT_Box/Modules
/home/gnagflow/rtb/Projects/NAT_Box/Modules/Clib
/home/gnagflow/rtb/Projects/NAT_Box/Modules/NAT_Engine
/home/gnagflow/rtb/Projects/NAT_Box/Modules/NetMon

This structureresemblesthedirectory structureasit is createdon theCVSserver.
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5 PROJECTS 5.4 Projectentry status

5.4 Project entry status

RTB definesasetof statusesfor project entries.Thestatusof anentry canbeoneor moreof thefollowing:

� unknown

The status of the entry is currently unknown. This is usually the case,if an entry hasbeennewly
addedor if RTB did not yet receive theentry’s CVSstatusfrom theCVSserver.

� up to date

Theentry is consistent with theentryon theCVSserver.

� local only

Theentry only exists asa local copy. It hasnot beenyet checkedinto CVS.

� locally modified

Theentryhasbeen modifiedlocally. This caneither mean,thatsourcefiles of a modulehave been
modifiedor propertiesof theentry itself.

� files added

This statusonly applies to modules. New files have beenadded to the moduleandhave not been
checkedinto CVSyet.

� files deleted

Thisstatusonly appliesto modules. Fileshavebeenlocally deletedfrom themodule andthemodule
hasnot beenupdatedin CVSyet.

� internal error

This statusshould never occur. It meansthat RTB cannot make sense of an entry. If this status
occurs,you should delete theentryandrestart RTB.

5.5 Project Window

Eachproject in RTB canbedisplayedin its own project window (Figure7). Thereis no limit in how many
project windows canbe opened at onetime, except the machine’s resourcesandthe user’s capability of
keeping control. Theprojectwindowconsistsof four parts:

� Menubar

Themenubar providesfunctionsto manage theproject.

� Toolbar

Many functionsof themenuareduplicatedherefor easeof use.Most frequentlyusedfunctionscan
beinvokedusing a single button click.

� Project basicsetting

Thename,sourcepathandCVS repository areshownherefor fastproject navigation whenusing
multiple projectwindows.
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Figure7: ProjectWindow
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� Detailed informationnotebook(tabs)

Heremoredetailed information abouttheprojectis displayed:

– A treeshowing theproject entries;

– A list of processesdefinedin theproject;

– A list of optionsused for theproject;

– Whether or not theprojecttarget will contain debug information.

5.6 Project Overview Tab

The“Project Overview” tab(Figure8) showsa treecontainingall the targets,message setsandmodules
that aredefinedin the project. It displays the mostimportant attributesof theseentriesin the following

Figure8: ProjectOverview tab

columns:

� Name

Thename of theentry.

� User

Shows thenameof theuser who hascurrently locked this entry, if any.

� Tag

Thenameof the tag, if theentryhasbeencheckedout using a tagdefinition.

� Status

Thecurrent status of theentry. This canbea combination of oneor morestatusesasdescribed in
section 5.4.

� Checkbox

Thecheckboxindicates, whether or not theentryis usedin thecurrentproject.
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5.6.1 Adding entries to a project

To addanentryto a project you have two options:

� Creating a new entry

To create a new entry, select the category in the treeyou want to createin (target, message set,
module). PresstheNewbutton in thetoolbaror usetheEntry->New menuentry. Whenusingthe
menuentryit is not necessaryto selectthecategory in thetree,asyou canselect it from themenu.

� Importing anentry

To importanentryfrom your local filesystem,usetheEntry->Import->... menuentry. A filedialog
will askyou for thelocation of the.rtb configurationfile of theentry you want to import. Select
a file from the list andthe entry will be added to your local entry list. An imported entry will be
local andnot associatedwith CVS. You will have to checkin the entry if you want to manage it
with CVS.

� Checking out anexisting entryfrom CVS

To checkout an entry from CVS, press the Repository Manager button in the toolbar or select
theEntry->CVS checkout menuentry. This will bring up theCVS Repository Managerwindow
whereyou canselect the entriesyou want to check out. Seechapter9.3 on page 35 on how to do
this.

When checking out an entry from CVS, it will be active by default (seeSection5.6.4) and therefore
automatically includedin thenext build.

5.6.2 Editing entries of a project

If you want to edit an entry, selectthe entry from the list andpress the View/Edit button in the toolbar
or select theEntry->V iew/Edit menuentry. Depending on thetypeof theselectedentry, theappropriate
view/edit dialog for theentry will appear. Edit thevalues for theentryandpressOK to closetheview/edit
dialog.

5.6.3 Deleting entries fr om a project

To delete anentryfrom a project,click thedeletebutton in thetoolbar or select Entry->Delete from the
menu.RTB will askyou to confirmthedeletion of theentry.

Note: Theentry will bedeletedfrom theproject entry list, however, it will not bedeleted from thedisk.
This is a safety feature to prevententriesfrom beingdeletedaccidently.

5.6.4 Defining active entries

Whenanentry appearsin theentry list, it doesnot necessarily mean,that it alsousedto build theproject.
Youcanselecttheentriesthatwill beusedfor building thetarget system by selectingthecheckboxesat the
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Figure9: Activated project entry

right side of theentry. A greenchecker will appearto indicatethat theentrywill beusedwhenbuilding
thesystem(Figure9). Checked out entrieswill beactive,newly added entrieswill beinactiveby default.

This is useful if youwantto select betweensimilar, but slightly different,modulesor targetdefinitionsfor
building a system.You caninclude bothtargetsinto your projectandselect either oneof themto testout
theeffects. Thesameis, of course, truefor modulesandmessage sets.

5.7 ProcessesTab

This tab (Figure10) shows a list of currently defined processeswhich will run in themodulescontained
target system.It only shows processesthat arein active modules, it will not show processesof inactive
modules.

Figure10: ProjectProcesses Tab

Whenamodulecontainingprocessesis addedto theproject andactivated,its processeswill appear in the
processlist with their default settingsasthey aredefinedin themodule.

The list will be sorted by the order in which theinit functionsof the processeswill be calledduring
initi alization of ROME.

5.7.1 ChangingProcesssettings

You canchange the processsetting on a per project basis. Selectthe processin the list and pressthe
Changebutton or double click the processentry. The processedit window (seeFigure24) will appear
andyou canchangethesettingsfor theprocess.Thechangeswill only affect the current project andwill
not transfer to any other project.

A changedprocesswill beindicatedby a little pencil on theleft sideof theprocessentry.
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5.7.2 Reverting changes

If you want to reset the valuesof a process to its default settings (asdefinedin the modulewherethe
processis defined), select theprocess from thelist andpress theResetbutton.

5.8 Options Tab

The “Options” tab (Figure 11) shows a list of all availableoptions in all active modules in the project.
You canselect whetheror not an option is activated. Active options will generatea #define in the
Hardware.h includefile. This way you canpassdefinitionsto sourcefiles without changing thesource
codeitself.

Figure11: ProjectOptionsTab

5.8.1 ChangingOption values

You canchange the value of an Option by entering the new valuein the ’Current Definition in Project’
textfield andpressing the’Change’ button. TheOption valuewill thenbechangedfor this project only. In
otherprojectsthe changesherewill have no effect. A changedOption valuewill be indicatedby a littl e
pencil neartheOptionID.

5.8.2 Option Default values

You cancheck the default valueof the Option by selecting the ’Default’ tab. If you want to revert the
Optionvaluefor this project to its original default setting, press the’Reset’button.
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5.9 Misc Tab

As the namemight let you expect, the “Misc” tab (Figure12) show miscellaneous features,optionsand
selections for the project. Currently there is only onecheckbox which lets you decide whether or not a
symbol table for the ROME debuggershould be generatedandincludedinto the target. Of course, this
only makessense,if you have implementeda debugger (or anothermodule that needsthesymbol table)
for your target.

Figure12: Project Misc Tab

6 Targets

Targetsdescribe the configuration of specific target hardware setups. Therefore, a target contains all
informationthatis machinedependent.Usuallyonecreatesa target for avery specific hardwaresuchasa
single board, anembeddedsystem or aspecific configurationof anevaluation system.Thetargetcontains
thefollowing information:

� CPUtypeandclass(e.g.MIPSr4300);

� Compiler/Linker settingssuchascompiler/linker flags,warning/optimization level anddebuginfo
flag;

� Definitionsfor themake process;

� Definitionsfor a specific install task;

� Hardwaredefinitionslike memorylayout, IO spacesetc.

Mostof thetimeyoucan not re-useatarget for anothersystem,however, youmightbelucky if thesystems
areclosely related.

6.1 Target configuration file

In our example, thetarget configuration file will bestoredas

/home/gnagflow/rtb/Projects/NAT_Box/Targets/DDB-VR4111U-eval-board/DDB-
VR4111U-eval-board.rtb

At first, it seemsa bit odd, that the nameof the target actually appearstwice in the path,asa directory
nameandasthe filenameitself. However, this namingmakesCVS operations muchmoreintuitive and
easier.
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6.2 Target dialog

You canopen the target dialog (Figure13) by selecting a target from the list in the project window and
clicking the Edit button or selecting theEntry->V iew/Edit menuentry. This dialog providestextfields

Figure13: Target Dialog

to enter a nameand description for the target as well as a set of notebooktabsto entermore specific
informationsuchas:

� CPUclassandtype

� CompilerandLinker settings

� Makefile definitions

� Install definitions(suchasscripts)

� Hardwareconfiguration
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6.2.1 CPU class and type

The CPU classand type define, together with your toolchain basepath setting in the preferencesdi-
alog, the path to the toolchain for a specificprocessor. If, for example, your toolchain basepath is
/p/sa/rome/v2.0/Tools, yourCPUclassis MIPSandtheCPUtypeis setto r4111, your toolchain
pathwill expand to:

/p/sa/rome/v2.0/Tools/MIPS/r4111

WhenRTB createsMakefiles for the target build, it will includethis path. All toolchain executables
mustbelocatedin this directory in order to run a successful make.

6.2.2 Compiler and Link er settings

In the “Compiler/Linker” tab (Figure14) you candefinethecompiler’s behaviourwhencompiling your
sourcefiles. You canenterthefollowing information:

Figure14: TargetDialog CompilerSettings

� EnableCompiler Warnings

Thischeckboxdefines, whether or not thecompilerwill generatewarning messageswhencompiler
your code.If you enablethecheckboxit will addthe“-Wall” flag to thelist of compiler flags.

� EnableDebug Info

Enabling this checkboxis equivalentto adding the“-g” flag to thecompiler flags.

� Optimization

This line controls theamount of compilercodeoptimization. Thesettingsaddthe“-O1”, “-O2” or
“-O3” compiler flags,respectively.

� AdditionalCompilerFlags

In this textfield you canenter morespecific compiler flags,whichwill beadded to thecompiler flag
list.
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� AdditionalAssemblerFlags

Theseflagswill beadded to theassembler’s flag list.

� Linker Flags

Enteraddition linker flagshere.

� Input File

RTB generatesaninput file for thelinker. Theinput file containsall information thelinker needs to
know suchasoutput file format,memorylayout of the target executableanddefinescertain labels
suchas_bss or_end. Thecorrectnessof thisentryis crucial for creating aworking executable.If
you arenot familiar with thelinker input file syntaxor semantic, you should not changethis entry.
If you want to create a new target for a processorclassfor which an input file definition already
exists,it might work in somecasesto copy thisentry. Referto thelinkerdocumentation, if youhave
any problems.

Enteror changethevalues andpressOK to update thetarget settings.

6.2.3 Makefile definitions

In the“Make” tab(Figure15) you candefinethemake rulesfor compiling your sourcefiles. As usually

Figure15: TargetDialog Make tab

all ROME source files arewritten in Assembler, C or C++, these rulesarealwaysthe sameandcanbe
re-used from project to project. however, you might want to addcertain rules,if you, for example,have
a specific input languagewhich hasto be pre-processedor compiled by a specific tool, you canaddthe
build rule for thesefile here.
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6.2.4 Install definitions

The “Install” tab shownin Figure16 allows you to entercommands for installing the executable on the
target. Thesecommands will beaddedto theinstall: section of theMakefile. Soyou canexecute

Figure16: TargetDialog Install tab

thesecommandswith themake install commandline in your shell.

6.2.5 Hardware definitions

Figure17 shows the “Hardware File” tab. Hereyou can add the hardware definitions for your target.
Thesesettingsarevery specific.You will have to look up your target hardwarespecifications in order to

Figure17: Target Dialog HardwareFile tab

know which valuesto enterhere.

7 MessageSets

A message setdefines,asexpected,a setof ROME messagesandevents.Although it is calleda message
set,it actually contains definitionsfor bothmessagesand events. Thesemessagesandevents areusedfor
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inter processcommunicationof modulesin a ROME system. Somemessage sets,like “Standard”, are
required for almostany conceivablesystem. Othermessage setsareonly used, if specific functions are
needed(e.g.timer functionality).

7.1 MessageSetconfiguration file

In our example, themessage setconfigurationfile for the“Standard” message setwill bestoredas

/home/gnagflow/rtb/Projects/NAT_Box/MessageSets/Standard/Standard.rtb

As mentionedfor target configurationfiles, thepathnamingis defined by CVS.

7.2 MessageSetDialog

To openthemessagesetDialog (Figure18), select a message setfrom the list in theproject window and
click theEdit button or selecttheEntry-V iew/Edit menuentry.

Figure18: Message SetDialog

You candefinethenameof themessagesetandthebaseaddress for messageandeventnumbering. RTB
will create#defines andC structs in theMessages.h file andusetheinformationprovidedhere
for messageand event codenumbering. You must make surethat message set baseaddressesdo not
overlapto prevent conflicts.

On thelower left sideyou canselect from thelist of messagesandeventsfor themessageset.
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7.2.1 Adding a message

To addamessageor eventsimply selecttheappropriatetabandenterthenameandC structuredefinitions
in thetextfields. PresstheAdd button to addthemessage or eventto thelist.

7.2.2 Edit a message

To changea message or event, select it from the list andsimply change its values in the textfield. The
changedvalueswill automatically beupdatedin themessagesetonceyouleavethedialogor selectanother
message/event.

7.2.3 Deletea message

To deletea message,select themessagefrom thelist andpress theRemove button.

8 Modules

Modulesarethemainbuilding blocksof aROME system.A modulecontainsamoduledescriptionwhich
contains:

� A list of processesthatarerunning in themoduleaswell astheir priority, stack sizeandkey entry
points;

� A list of sourcefiles thatareusedfor building themodule;

� Definitionsfor creating a library versionof themodule(not implementedyet);

� A list of optionsthat canbeapplied to themodule.

8.1 Module configuration file

Themoduleconfigurationfile for themodule“NetMon” in our examplewill bestored as

/home/gnagflow/rtb/Projects/NAT_Box/Modules/NetMon/NetMon.rtb

Within the/home/gnagflow/rtb/Projects/NAT_Box/Modules/NetMon/ directory, RTB will
alsostore all sourceandheader files associatedwith the“NetMon” module.

8.2 Module Dialog

Themoduledialog (Figure19) givesyou thepossibility to editall important attributesof amodule. When
themoduledialog is activatedfor thefirst time, it comesup with the“Processes”tabactive. If you select
another tab, this setting will be remembered for the next time you openthe module dialog, even if you
openanothermodule.

27



8.2 ModuleDialog 8 MODULES

Figure19: Module Dialog

8.2.1 Processestab

The “Processes”tab (Figure20) showsa list of the processesdefinedin the module. It displays the
informationabout:

� Init order of theprocess

� Nameof theprocess

� Nameof theinit function, themainprocessfunction andthequeue handler function

� Process priority

� Process stacksize

Theserepresentthedefault valuesthatareusedwhenanew module is added to aproject.They aredefined
on a per modulebasis.However, they canbe changed on a per project basis in the project window (see
section5.7, page19). Changeson projectbasis will not affect thesettingsof themoduleconfiguration.

You canadd, edit anddelete processentriesfrom the moduleconfiguration by selecting a processfrom
thelist andclicking theoneof thebuttonson theright sideof theprocesslist.
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Figure20: Moduledialog“Processes” tab

Figure21: ModuleWindow “Source Files” tab
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8.2.2 SourceFiles tab

The“Source Files” tab (Figure21) givesyou the ability to add or remove sourcefiles from the module.
You canselectbetweenC (which includeAssembler) andH(eader) files andadd or remove files using
thebuttonson the right sideof thedialog. Whenadding files you will beasked, if you want to copy the
files into themoduledirectory, or just addthemto theconfiguration.Usuallyyou wantto copy themfrom
another location into themodule directory. However, in somecases (e.g.you areadding new files into an
already existing module directory) you just want to make the new files known to RTB. In this caseyou
don’t needto copy thefiles (althoughit would do no harm).

For Headerfiles you canselectwhich files should be exported, e.g. which files should be placedinto
themaininclude directory whenthe target systemis built. It makessenseto definethe interfaceof a
modulein a specificheader file, which will then beexported,while keeping definitions, thatshould only
beknowninside themodule,in private header files. To export a header file you cancheckthecheckbox
at the left sideof thefile entry. In theexample in Figure22 thefile nmon.h is exported,while theother
two files areprivate to themodule.

Figure22: Exporting Headerfiles

8.2.3 Library Settingstab

The“Lib Settings” tabhasno function yet,asthis functionality is not yet implemented.

8.2.4 Options tab

Every modulecancontain a setof options. A module option will be translatedin to a #define when
the system is built. Options therefore enable the possibility of creating conditional codeor of providing
certain valuesto take effect at compiletime. Theoption tab(Figure23) givesanoverviewof theoptions
definedin the module. You canselect options,edit their values, add or delete them. To edit an option,
simply select it from the list andchange the option valueon the right sideof the dialog. To delete an
option, select it from the list and pressthe deletebutton. To add a new option, enteran option name
into the textfield, enter the option value(if appropriate) andpress the addbutton. Option valuescanbe
anything from single digit numbers to complex structuresor code. Rememberthat the option valuewill
appear on the right side of the #define. If you want to usemultiple lines, you will have to add the
backslashes (\) at theline endings
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Figure23: Moduledialog “Options” tab

8.2.5 Process view/edit dialog

This dialog(Figure24) givesyou theoption of creating or changing a processin a module.Simply enter
thevaluesyou wantinto theappropriate fieldsandpressOK.

The“Processusesstdio” checkbox mustbeenabled if your processusesIO functions like, for example,
printf(). If this checkbox is enabled, the ROME initialization codewill open a connection to the
system console for this process. This presumes,of course, that a console process is included in the
system.

Note: Thenamesof theinit function, theprocessmainfunctionandthequeuehandler expand asyoutype
in the processname.Usually it’s a goodideato keepthese names, asit will produce a consistent
naming schemethroughout modules. However, for whatever reason, you canchangethenamesof
thefunctionsafteryou completed typing theprocessname.

9 CVS Repositories

CVSrepositories defineCVSservesin thenetwork thatcontain ROME targets,messagesetsor modules.
YoucancheckoutROME componentsfrom aCVSrepositoryanduseit in yourproject. It doesnotmatter
wheretheCVS repository is actually located. As long asyou know theserver name,theroot pathfor the
ROME repositoryontheserverandtheusername/passwordcombination, youcanusetheCVSrepository.
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Figure24: Process edit dialog

9.1 CVS RepositoryWindow

Whenyou first startRTB andopenup the CVS Repository Managerwindow it will beempty. You will
haveto addCVSrepository serverentriesin order to usethem.After youhavedonethatyougetawindow
like shown in Figure25. Thiswindowshowsa list of all known repositoriesaswell astheserver location.

Figure25: CVSRepository Manager Window

9.1.1 Adding a CVS Repository

To adda new repository, press theAdd button. You will bepresentedwith a dialog (Figure26) to enter
theinformationabout therepository andtheserveronwhich therepository resides.Youwill haveto enter
thefollowing information:
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Figure26: CVSRepository add/edit/view dialog

� Repository Name

The nameof the repository entry. This is the nameas it will appear in the repository list in the
repository managerwindow. This is not thenameof theserver.

� CVSrepository location

The place wherethe repository resides. This canbe your local machine or a server. If you select
server you alsohave to provide:

– Servername

The nameof the server machine. This is the real nameof the actual CVS server. In our
example thenameof themachine andtheentry arethesame.This is, of course,not necessary.

– Username/Password
Theusernamepassword combination for theCVS server. If you setup your own server, you
will know it, otherwise askthe administrator of the server. If you do not want to storeyour
password in the RTB configuration file, you canactivate the ask me checkbox. In this case
RTB will askyou for thepassword if it needsit. It will not bestored your disk.

� CVSRootDirectory for Repository

Hereyouhaveto entertheCVSroot directory asit is definedfor theROME repository ontheserver.
Again, if you setup therepository yourself, you will know theroot directory. If not, you will have
to askyour thesystem administrator.

� UsecompressionwhenaccessingCVSServer

CVS canusecompression whentransferring files. This is very useful, if you usea slow network
connection suchasamodemor youhaveaserveron theother sideof theglobe. If in doubt, activate
thecheckbox. It won’t hurt.
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Onceyou have entered all information, press OK to addtheentry to thelist.

9.1.2 Edit a CVS Repository entry

To edit an entry, select it from the list andpressthe Settingsbutton. The samedialog asdescribedfor
adding entrieswill beusedfor changing anentry.

9.1.3 Deletea CVS Repository entry

To delete a repository entry, select it from the list and pressthe Deletebutton. You will be asked to
confirmthedeletion andtheentrywill beremovedfrom thelist.

9.2 Browsing a CVS Repository

To browsethe contentsof a CVS repository, press the Browse button. A repository browser window
(Figure27) appearson the screen andshows the content of the repository in form of a entry tree. The

Figure27: UnassociatedCVSRepository BrowserWindow

treelooks very similar to thetreein theproject overview tabof theprojectwindow. However it shows the
entrieslocatedon theCVSserver.

Therepository browserwindow shown in Figure27 is not associated with any project. You canbrowse
therepository andupdate thetree,but you cannot check out any modulesat this point. In orderto check
out modules,you have to associatethebrowserto a certain project. Seesection9.3on how to do that.
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9.3 Checking out an entry

To checkout an entry, pressthe Repository Browser button in your project window. This will opena
repository browser window (or raise analready existing window of that repository) andassociateit with
theproject. As you canseein Figure28, it now contains thenameof theproject anda checkout button.
To check out oneor moreentries,simply select themandpresstheCheckout button.

Figure28: AssociatedRepository BrowserWindow

9.3.1 Checkingout a singleentry

If you want to check out a single entry, you will bepresentedwith a checkout dialog asshownin Figure
29. If you want to check out the current version of the entry, you cansimply click OK. However, you
have theoption to check out a specific version of theentry by selecting the“ChooseTag” radiobutton and
selecting atagfrom thelist. The“Entry Info” textfield will show additional informationabout theselected
tag,asit hasbeenentered whentheentry wascheckedin.

9.3.2 Checkingout multiple entries

If you select morethan oneentry, you will not have the option to choosespecific tagsfor eachentry. A
reminder dialog (Figure30) will appear on the screen to confirm that you want to check out the latest
version of all selectedentries.
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Figure29: Checkout dialogfor a single entry

Figure30: Info dialog whenchecking out multiple entries
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